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ATLASSII+ USERS MANUAL 

1. Overview: Asset Tracking for Logistics and Supply System, Phase 
II Plus, (ATLASS II+) is the management information system designed 
to provide the U.S. Marine Corps with a real-time view of 
organizational and intermediate level maintenance, supply, and 
material readiness support. The system allows maintenance and supply 
officers to track all equipment, gear, and assets inducted into the 
maintenance cycle, to requisition parts online, and to control 
assets from a single, integrated platform. ATLASS II+ is the Marine 
Corps' integrated supply, maintenance, and material readiness system 
providing functional tasks and reporting features in support of 
asset management.   
 

a. Purpose:   
 

1) To clarify policies and procedures inherent to Marine Corps 
Integrated Maintenance Management System (MIMMS) as they relate to 
the Asset Tracking Logistics and Supply System II+ (ATP). 
 

2) A basic walk-thru of the ATP computer program is assumed to 
have been accomplished prior to a review of this manual.  Understand 
that this manual is not all inclusive of the ATP application.  More 
comprehensive understanding must be obtained through unit 
supervisory personnel. 
 

3) This manual is sponsored by MCLCAT EAST.  Any recommended 
changes or additions to this manual should be addressed to MGySgt 
Collier 910-450-0883 or e-mail at collierhe@lejeune.usmc.mil   
 

b. Special Qualifications:  The system administrator (commodity 
manager) establishes your ability to access ATLASS II+ options. Your 
access depends on the Special Qualifications (SQs) the system 
administrator assigned to you. If you have access to the System 
subsystem, you can view your SQs.  You should have a clear 
understanding of what your permissions are within ATLASS II+.  A 
common cause of error messages is attempting to access a function 
without the correct permissions. 
 

c. Getting Help: The ATLASS II+ User Guide (within the 
application) is designed to provide information about each of the 
software's menu options, including task overviews and software 
procedures (instructions).  Procedures are written under the 
assumption that the user is using the involved application screen, 
and therefore illustration is not required. The ATLASS II+ User 
Guide is available throughout the system from the Help menu or by 
using the F1 key. 
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1) As you move through the application, window descriptions and 
procedures are available through the Ctrl-F1 key. This type of help 
topic is called Window Help or context-sensitive help.   
 

2) When you are entering or reviewing data, you can use field 
help to learn about a given item. Field help is available by placing 
your cursor in a given field and pressing the Shift-F1 key. Certain 
types of screen objects do not support field help. In these cases, 
you will receive a message stating that field help is not supported. 
 

3) Other topics are included in the guide in order to provide 
overviews and access to information outside of the context-sensitive 
calls within the application. These topics were written to provide 
process-based explanations of tasks or to give an overview of an 
application area. Our assumption in providing this point of entry 
into the online user's guide is that you may be new to this 
application, or to a given element within it, and that you would 
like to review basic information before beginning to work in the 
application. Additional instructions such as menu path information 
and task notes are included to clarify the context of certain 
procedures so that you can find your way to the application screen. 
You can access the user's guide through the Help menu or from a 
procedural help window by clicking Help Topics. 
 

d. Security in ATLASS II+:  Your security access determines what 
applications you see, what menu options within an application you 
see, and what data you see. The procedures documented in this User's 
Guide assume that you have full access to the option in question. 
 

1) ATLASS II+ is a password-controlled system. Access to ATLASS 
II+ data is controlled by three levels of security, which are 
briefly described below. 
 

a) System Access Security. Access to ATLASS II+ is controlled 
at the system level by requiring the user to enter a valid password. 
 

b) Screen Security. At the screen level, passwords and 
associated Authorities determine a user's accessibility to the 
subsystem database.  These security checks are controlled 
programmatically from the system's security files. 
 

c) Data Field Security. Certain data entry, updates or 
deletion of screens, or any option that updates the database, 
requires additional restrictive security qualifications. All or 
selective fields on these screens require additional system-
controlled Authorities.  
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2) Personnel at each site maintain password and other security 
codes responsible for system administration activities.  The system 
is designed to require an Authority to access or update security 
information in compliance with OPNAVINST 5530.14 (series).  The 
ATLASS database does not contain any classified information.  
However, the system has a variety of sensitive components that 
require protection due to the potential risk and magnitude of loss 
or harm that could result from improper operation or deliberate 
manipulation of this data.  This sensitive data, which affects 
automated decision making, includes the following: 
 

a) Job statuses of repair actions that result in assignment 
of personnel resources within a work center. 
 

b) Scheduled maintenance requirements and actual statistics 
showing use and remaining performance intervals of engines, engine 
modules and components, and support equipment.  This information is 
used to control scheduled repair actions and planned obsolescence 
for this equipment. 
 

3) All personnel involved with ordering parts to include SL-3 
items, evacuating equipment to higher echelons of maintenance (to 
include 1st echelon to 2nd echelon), and repairing or inspecting 
equipment must be assigned a user ID and password.  This is done 
through the unit’s FSA.  Once a Marine has their user ID and 
password the commodity’s supervisor must assign him/her SQ’s.  
 

e. Manual Usage:  This manual is not an all-encompassing ATP 
reference manual.  Unit supervisory personnel are the main source of 
more comprehensive ATP training.  This manual will not be used as 
precedence to set policy.  However, discussion of current policies 
and procedures and their relationship with ATP is done throughout 
this manual.  The prudent management policies and procedures as 
addressed in the MIMMS Field Procedures Manual, MCO P4790.2_ must 
also be adhered to in order to maintain a viable maintenance 
program. 
 

f. Sytax Descriptions used in this Manual:  Basic computer skills 
such as keyboard and mouse usage, Windows NT and ATLASS II+ 
familiarity, and the availability of supervisory personnel for help 
with situations not covered in this manual are assumed.   
 

1) Menu selections will be all capital letters and in bold 
print.  For example:  WORKORDER – this refers to the “workorder” 
menu selection. 
 

2) Subordinate menu selections will be separated by an “>” also 
in bold print.  For example: WORKORDER>NEW>INDIVIDUAL – refers to 
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the menu selection called “workorder” with a subordinate menu 
selection of “new” which has another subordinate menu selection of 
“individual”. 
 

3) Window names will be in italicized lettering.  For example 
the window where you will start a new work order will be referred to 
as New Work Order window.  Parts of windows (frames, buttons, drop 
down menus, etc.) will be referenced in Title Case. 
 

4) In some instances throughout this manual pictures of actual 
help screens from the ATLASS II+ are presented. 
 

g. Some terms and definitions: 
 

1) Work Order (WO):  The purpose of the work order is to 
consolidate all tasks associated with a particular item of equipment 
in the maintenance cycle.  
 

2) Work Order Number (WON):  A WON is an identifying number 
assigned to a work order.  This number is automatically assigned to 
a WON.   
 

3) Task:  Tasks are used to manage equipment defects within 
ATP.  Once a task is initiated it will automatically be assigned an 
identifying number.  Individual tasks are associated to parent work 
orders.  The purpose of a task is to request modification (MOD), 
calibration (CAL), corrective maintenance (CM), preventive 
maintenance (PM), and inspections (INSP) on all ground equipment 
within the unit's maintenance capability.  The task is also used for 
transmitting work to supporting maintenance activities and for 
recording and reporting maintenance performed.  Maintenance 
personnel will initiate a task in all instances where either 
maintenance resources, repair parts, or secondary repairables are 
required to perform requested maintenance.  A principle end item can 
have only one WON associated to it.  A WON can have multiple tasks 
associated to it.  
 

4) Mailbox:  A screen where task approvals, acceptances, and 
deletions are made, part requisitions are authorized, notification 
of required work is flagged and other important managerial 
information is sent and worked on. 
 

5) System Qualification (SQ): SQs are assigned to personnel on 
an as needed basis to operate commodities in day-to-day functions.  
This is a commodity manager responsibility.  Maintenance and supply 
personnel using ATP must have the ability to operate their 
commodities to the lowest level of leadership.  This is accomplished 
by giving users as much access to ATP functionality as deemed 
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necessary by commodity managers.  Therefore, all commodity managers 
should be able to adjust the system qualifications of the personnel 
assigned to the section as the daily mission dictates.  Commodity 
supervisors should have access to the SECURITY>PERSONNEL menu 
selection within the system menu of ATP.   
 

6) Application Administrator:  Personnel authorized to adjust 
SQ’s for personnel are application administrators.  You can 
determine application administrators because they have access to the 
SECURITY>PERSONNEL  menu selection within the system menu of ATP.  
Normally commodity managers are application administrators. 
 

7) Functional System Administrator (FSA): The FSA is 
responsible to maintain the ATP system and assign personnel user IDs 
and passwords.  He/she is also the liaison between system users and 
the ATP helpdesk.  The FSA should not be responsible to assign SQs 
for users unless local standard operating procedures (SOPs) 
stipulate that they are.  The commodity managers should assign SQ’s 
to commodity personnel. 
 
2. Responsibilities 
 

a. Preparing Activity.  The preparing activity may be the 
equipment owner, the equipment user; for example, the equipment is 
on temporary loan, or the equipment custodian as in the case of the 
maintenance section evacuating to supporting maintenance activities.  
The preparing activity is responsible for initiating tasks and 
includes completion of the basic task information and approval of 
the task.    
 

b. Maintenance Unit:  The maintenance section performing the 
approved maintenance will begin repairs on the equipment by 
accepting the task.  The maintenance section will enter information 
on work performed as maintenance actions are completed and will 
close out the task when work is completed and the equipment owner 
accepts the equipment back.   
 
3. User IDs and Passwords: All personnel involved with ordering 
parts to include SL-3 items, evacuating equipment to higher echelons 
of maintenance (to include 1st echelon to 2nd echelon), and 
repairing or inspecting equipment must be assigned a user ID and 
password.  This is done through the unit’s FSA.  Once a Marine has 
their user ID and password the commodity’s supervisor must assign 
him/her SQ’s.  
 
4. ATLASS II+ Main Menu: The main ATLASS II+ menu is the launching 
point for entering any of the five ATLASS subsystems: Maintenance, 
Supply, Readiness, Reports, and System. 
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5. Navigation in ATLASS II+: You will access options within the 
program using either menu bars or toolbars or a combination of the 
two. These two bars appear consistently throughout ATLASS, although 
your choices on them change according to the subsystem you access 
and the SQs you have. 
 

a. Status Messages: A third feature that appears consistently 
throughout ATLASS is the status bar. Located at the bottom of the 
ATLASS screen, it reports the progress of your tasks with text 
messages or instructions that appear on the left side. The screen ID 
appears to the right of the text messages. Other status bar 
information includes the current date and time, the user ID of the 
person currently logged in, and the organization that user belongs 
to. 
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b. This manual will mainly concentrate on the maintenance aspect 
of ATP. 
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Layette Management enables you to track repair parts in the 
maintenance shop. These procedures assume that you have the 
necessary system qualifications to perform the documented task. 
Refer to the 'Help' option in ATLASS for an explanation on how to 
use layette management. 
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6. Equipment Modification Management:  ATP provides an automated 
modification control program to support ground maintenance 
equipment. 
 

a. Listings:  From the Maintenance window click on 
Modifications>Listings.  This will access the End Item Modification 
Selection window. 
 

1) Select either the TAMCN, Serno or NIIN for the equipment 
list.  After the selection has been made click OK to enter the 
listing, Cancel to return to the End Item Modification Selection 
menu, or click Help to access the help menu. 
 

2) At the PEI Modifications window the user will need to verify 
the Modifications Outstanding window.  Modifications are 
automatically added to this window on a quarterly basis as the SL-1-
2 and SL-1-3 is updated.  The functions to be performed in this 
window are as follows: 
 

a) Complete:  Select the modification that has been completed 
by clicking on the appropriate MI and clicking the Complete button.  
This will move the MI to the Modifications In Work, N/A, or 
Completed window. 
 

b) Not Applicable:  Select the modification that is Not 
Applicable by clicking on the appropriate MI and clicking the Not 
Applicable button.  This will move the MI to the Modifications In 
Work, N/A, or Completed window. 
 

c) WO/Task:  Select the modification that needs to be applied 
by clicking on the appropriate MI and clicking the WO/Task button.  
This will prompt the user for a Login Name and Password.  At this 
point a Task has been created and sent to the mailbox pending 
approval and acceptance. 
 

3) At the Modifications In Work, N/A, or Completed window the 
following functions can be performed: 
 

a) Verify:  Select the modification that has been verified as 
complete by clicking on the appropriate MI and clicking the Verify 
button.  This will place a check in the Mod Verf check box and 
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assign the date of the verification. 
 

b) Revert:  As modifications are annotated as Complete or Not 
Applicable they will move into the Modifications In Work, N/A, or 
Completed window.  The Revert button will move a modification back 
to the Modifications Outstanding window by clicking on the MI and 
clicking the Revert button. 
 

4) Save:  This button will save the changes made in the PEI 
Modifications Window and return the user to the End Item 
Modification Selection window. 
 

5) Cancel:  This button will return the user to the End Item 
Modification Selection window.  Click Cancel to return to the 
Maintenance window. 
 

b. By End Item:  From the Maintenance window click on 
Modifications>End Item.  This will access the End Item Modification 
Selection menu. 
 

1) Select either the TAMCN, Serno or NIIN for the equipment 
list.  After the selection has been made click OK to enter the 
listing, Cancel to return to the End Item Modification Selection 
menu, or click Help to access the help menu. 
 

2) At the Modifications Outstanding by End Item window the user 
will see a listing of outstanding modifications by end item. 
 

3) Create Task:  Select the modification that needs to be 
applied by clicking on the appropriate MI and clicking the Create 
Task button.  This will prompt the user for a Login Name and 
Password.  At this point a task has been created and sent to the 
mailbox pending approval and acceptance. 
 

4) Close:  This button will return the user to the End Item 
Modification Selection window.  Click Cancel to return to the 
Maintenance window. 
 
7. Maintenance History:  Maintenance history is designed to provide 
the user with access to the history of their equipment.  This field 
also has the capability of importing and exporting history 
information for equipment entering or leaving the command. 
 

a. From the Maintenance window click on Maintenance 
History>Search.  This will access the Maintenance History Search 
window. 
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1) The Organization and Section will default from the users 
Login Name.  Select either the TAMCN, Serno or NIIN for the desired 
equipment history.  The View menu will allow the user to tailor 
their search to specific maintenance functions.  However, all the 
view options will be available for view as separate folders in the 
Maintenance History window.  Click OK to enter the Maintenance 
History window, click Cancel to return to the Maintenance window, or 
click Help for the help menu. 
 

2) While in the Maintenance History window the user will have 
access to history pertaining to CM, PM, Inspections, Mod, Cal, 
Components, Gen History, Parts History, and Op History.  Click on 
the tab to be viewed. 
 

3) Once in the desired window select the WON or Task to be 
viewed and click the View button.  The View button will only be 
activated when information in the folder offers an additional view.  
 

b. Click Close to return to the Maintenance History Search window.  
From the Maintenance History Search window click Cancel to return to 
the Maintenance window. 
 
8. Utilities:  The utilities option provides the user with the 
capabilities to manage and update key information pertinent to 
organizations equipment. 
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9. PEB Mgmt:  The Pre-expended Bin Management option provides the 
maintenance shop with the necessary tools to establish and manage a 
PEB. 
 

a. Site:  From the Maintenance window click on PEB Mgmt>Site. 
 

1) New:  Click New to create a PEB listing.  This will prompt 
the PEB Site Add window. 
 

a) At the PEB Site Add window the Organization and Section 
will be defaulted based on the user’s Login Name. 
 

b) In the PEB Site window the user will enter the following 
information: 
 

1  Site Location:  Enter the physical location of the PEB.  
Example: Comm shop. 
 

2  PEB Id:  This is an entry where the unit can further 
identify information pertaining to the PEB.   
 

3  Site Name:  Enter the name of the site.  Example:  
Radios. 
 

4  Job Order Number:  Select the JON to be used when 
requisitions are submitted to replenish the PEB. 
 

5  Save:  Click Save to save the information used to 
create a PEB.  A new window will appear asking the user “Do you wish 
to establish a PEB inventory at this time”?  Click Yes to further 
establish required information for the PEB. 
 

6  At the Add PEB Inventory Record window the user can 
continue to process information for individual NIIN’s to be added to 
the PEB listing.  This is the window where the PEB is actually built 
from. 
 

a  NIIN:  Enter the NIIN for the part to be added to the 
PEB. 
 

b  PEB Loc1:  Enter the location of the part within the 
PEB. 
 

c  High Limit:  Enter the high limit of the NIIN to be 
maintained within the bin. 
 

21 



ATLASSII+ USERS MANUAL 

d  Low Limit:  Enter the low limit of the NIIN to be 
maintained within the bin. 
 

e  OH Qty:  Enter the current quantity of the NIIN to be 
entered into the PEB. 
 

f  After all entries have been entered click Apply.  If 
the OH Qty is lower than the High Limit the user will be asked if 
the part should be requisitioned.  Clicking Yes will send the 
requisition to the Mailbox under Indirect Parts Pending. 
 

g  Click Add to save all the information added.  The 
screen will clear and the user can add another NIIN to the PEB.  
Click Close to return to the PEB Site List.  Click Close to return 
to the PEB Site Add window, and click Close to return to the 
Maintenance window. 
 

b. List: Click PEB Mgmt>List to show a listing of all the PEB’s 
associated with the Organization.  This is a view only window.  
Click Close to return to the Maintenance window. 
 

c. Inventory:  From the Maintenance window click on PEB 
Mgmt>Inventory. 
 

1) List:  Click List to access the PEB Site Inventory list. 
 

a) From the Available menu select a specific section or 
multiple sections to be moved to the Selected screen.  This can be 
accomplished by double clicking on the section, or by clicking on a 
section and click ADD, or click and drag to the Selected screen. 
 

1  ADD:  Takes a specific section and adds it to the 
Selected screen. 
 

2  Remove:  Will remove a specific section from the 
Selected screen. 
 

3  Add All:  Adds all Available to the Selected screen. 
 

4  Remove All:  Removes all Selected to the Available 
screen. 
 

5  Click View.  This will pull up the PEB Inventory List. 
 

b) At the PEB Inventory List click Add to add new items to 
the PEB.  This process will access the Add PEB Inventory Record 
window.  This process is identical to establishing a new PEB.  Click 
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Close to return to the PEB Inventory List. 
 

c) Click Update to access the Update PEB Inventory Record 
window.  The user can update the High Limit, Low Limit, OH Qty, Due 
Qty, and PEB Loc1.   
 

d) Once these fields have been updated click Apply.   
 

e) Click Close to return to the PEB Inventory List. 
 

d. To delete an item click on the NIIN to be deleted and click the 
Delete button.  The User will be prompted to confirm the process by 
clicking Yes or No. 
 

e. After all transactions have been processed click Close to 
return to the PEB Site Inventory list.   Click Close to return to 
the Maintenance window. 
 

f. Search:  Click Search to access the PEB Inventory Search 
window. 
 

1) Enter the NIIN or Part Number to be searched and click OK.  
If the NIIN or Part Number is not part of the PEB the user will 
receive a Validation Error.  If the item is part of the PEB the PEB 
Search List window will appear. 
 

2) From the PEB Search List window the user can update the NIIN 
by clicking the Update button.  This process is identical to the 
update process mentioned above.  When the search or update is 
completed click Close to return to the Maintenance window.                  
                       
1) Additional Instructions: 
 
Helpful Hints 
 

(1)  Sort and Display:  Various screens throughout the 
ATLASS2+ program have the ability to be manipulated to the viewers 
preference.  For example:  From the Work Order Summary – by UND 
window we will show how to change the sort and display of 
information located in the List. 
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SP8.  Worksheet to update the PM schedule when a meter is replaced. 
 
The following steps will update the Due EOT column of the PM 
Schedule so that it will reflect the correct meter reading required 
to perform the next scheduled PM for equipment that had its meter 
replaced.  This computation must be computed for each frequency 
definition relating to the equipment. 
 
Step 1.  Record the reading from the old meter. 
 
Step 2.  Using the “PM Schedule” screen complete the following 
computations of the below worksheet: 
 

Column from PM 
Schedule screen Computation

Number in 
column/recorded 

Due EOT  
Old meter reading -  

 =  

Current meter reading +  
 =  

EOT Interval -  
This number will be 

entered in the 
Initialize PM 

checkbox 

=
 

 
Step 3.  Go to the PM Schedule window and highlight the item that 
had the meter replaced.  Click to update the record.  In the Update 
PM Schedule window put a check in the Initialize PM checkbox and 
enter the number you computed in the above worksheet into the block 
that appears.  Click apply and save.  The Due EOT will reflect the 
correct meter reading required to perform the next scheduled PM. 
 
Example: Using the following information: 
 
Old meter reading     = 39 
Due EOT               = 147 
Current meter reading  
  (from new meter)    = 1 
EOT interval          = 250 
 
Using this information here is what the worksheet would look like: 
 

Column from PM 
Schedule screen Computation

Number in 
column/recorded 

Due EOT 147 
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Old meter reading - 39 
 = 108 

Current meter reading + 1 
 = 109 

EOT Interval - 250 
This number will be 

entered in the 
Initialize PM 

checkbox 

=
-141 

(Notice this is a 
negative number) 

 
 
The number “-141” will be entered in the “Initialize PM” block.  
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